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1 List of resources 
 
ScitoVation maintains a collection of PLETHEM resources at https://www.scitovation.com/plethem/. 
 

1.1 Supporting files 

This guide includes an appendix with examples for each of the workflows called PLETHEM Workflow Tutorial Series: 

• Appendix 1: Step-by-Step Guide: Forward Dosimetry 
• Appendix 2: Step-by-Step Guide: Route-to-Route Extrapolation 
• Appendix 3: Step-by-Step Guide: High-Throughput In Vitro to In Vivo Extrapolation (IVIVE) 
• Appendix 4: Step-by-Step Guide: Reverse Dosimetry 
• Appendix 5: Step-by-Step Guide: Kinetically Derived Maximum Tolerated Dose (KMD) Modeling 
• Appendix 6: Step-by-Step Guide: Using Forward Dosimetry in Ecotoxicology 

This guide includes references to a number of sample files. These are available for download at 
https://www.scitovation.com/plethem/. 

 

File name Information 

plethem_in_vivo_time_course.csv Example of formatted file to import in vivo data 

plethem_biomonitoring_data.csv Example of formatted file to import biomonitoring data 

plethem_tra_exposure_estimates.xls Populated ECETOC TRA exposure estimation sheet 

plethem_seem.sqlite Data for SEEM exposure estimates 

plethem_batch_exposure_template.xlsx Excel file for importing exposures into PLETHEM. This file can be 
edited if the sheet names and column names remain the same. 

plethem_consexpo_estimates.csv Example file for importing ConsExpo exposure data 

plethem_kmd_data.csv Data for KMD analysis 

plethem_demo_project.Rdata Example of project that can be loaded and run 

 

The files needed to run the workflows can also be obtained by emailing plethem@scitovation.com. 

 

https://www.scitovation.com/plethem/
https://www.scitovation.com/plethem/
mailto:plethem@scitovation.com
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2 Introduction 
Population Lifecourse Exposure to Health Effects Model (PLETHEM) is an open-source package for physiologically 
based pharmacokinetic (PBPK) modeling written in R statistical language. The main aim of the package is to ease 
PBPK modeling for most applications by providing powerful modeling workflows wrapped in an easy-to-use and 
intuitive user interface. PLETHEM supports PBPK modeling, in vitro to in vivo extrapolation (IVIVE), and high-
throughput IVIVE. PLETHEM consists of a master database of physiological parameters, lifecourse equations, QSAR 
models, and chemical information. Additional physiological parameter sets or chemicals can also be stored externally 
as a user database. Finally, PBPK modeling workflows in PLETHEM save all the modeling data in a project file that 
is platform agnostic and can be opened through any other PLETHEM installation.  
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3 Scope and goal 
The goal is to guide the users through the workflows within PLETHEM by running through a few sample scenarios. 
We will provide detailed stepwise instruction and all the corresponding data files needed to run the following 
workflows.  

This document will describe: 

• Loading and running an existing PLETHEM project for PBPK modeling 
• Creating, running, and saving a new PLETHEM project for PBPK modeling 
• Importing exposure estimates for PBPK modeling 
• Running HT-IVIVE for estimating equivalent dose from in vitro point of departure 
• Running the Kinetically Derived Maximum Tolerated Dose (KMD) workflow 
• Running a new ecotoxicological project 

Problems, typos, or suggestions for improvement can be sent to plethem@scitovation.com with “PLETHEM Bug 
Report” as the subject of the email.  

mailto:plethem@scitovation.com
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4 Introduction to Physiologically Based Pharmacokinetic (PBPK) Modeling 

4.1 What is PBPK modeling? 

Physiologically based pharmacokinetic (PBPK) modeling is a mathematical tool for describing how a chemical 
distributes throughout a biological system—such as the human body—following an exposure. PBPK modeling 
integrates a physiological model of the body and compound-specific data to predict the pharmacokinetics (PK) of 
drugs and chemicals in plasma and tissues. The body, its constitutive organ systems, and the transit of a compound of 
interest are represented using a mathematical series of equations. The model equations are evaluated following a 
simulated exposure to estimate how a compound distributes across various organs over time, and how it is eventually 
eliminated from the body. 

 

4.2 What is PBPK modeling used for? 

4.2.1 Route-to-route extrapolation  

• This is used to estimate a dose through routes of exposure for a reference dose that was established 
through a different route of exposure. 

• Common use case: You have a known lowest-observed-adverse-effect level (LOAEL) for an inhalation 
exposure to a compound and would like to estimate an equivalent LOAEL for an oral exposure. 

4.2.2 Inter-species extrapolation  

• Since mammalian species share many common physiological characteristics, they may be expected to 
respond in a somewhat similar manner to toxic substances. While many differences exist between species, 
allometric relationships among physiological parameters can be used for quantitative interspecies 
extrapolation. 

• Common use case: You have a dose of exposure that results in a certain concentration in rats’ blood and 
would like to estimate the dose of exposure that would result in the same blood concentration in humans. 
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4.2.3 Intra-species extrapolation  

• This captures the human variability by including the life-stage of concern in the PBPK model. 

4.2.4 High-to-low dose extrapolation  

• PBPK models facilitate high-dose to low-dose extrapolation of tissue dosimetry by accounting for the 
dose-dependency of relevant processes (e.g., saturable metabolism, enzyme induction, enzyme 
inactivation, protein binding).  

• During the high-dose to low-dose extrapolation, no change in the parameters of the PBPK model is 
required except for the dose of exposure. 

4.2.5 Estimation of response from varying exposure conditions and across life stages  

• PBPK models can also be used to interpret biomonitoring data by estimating potential exposure doses 
(reverse dosimetry). 

• Coupled with pharmacodynamic (PD) models, these PBPK models can predict both dose-response and 
time-course for the development of adverse effects. 

4.3 Where to go for more information on PBPK modeling 

Reddy, M., Clewell, H.J., Andersen, M.E., and Yang, R.S.H. 2005. Physiologically Based Pharmacokinetic Modeling: 
Science and Applications, Wiley Inter-Science. 

Krishnan, K., and Andersen, M.E. 2007. “Physiologically-based pharmacokinetic and toxicokinetic modeling,” in 
Principles and Methods in Toxicology, A.Wallace Hayes, Ed., pp. 232–291, Taylor and Francis, New York, NY, USA. 

Kuepfer, L., Niederalt, C., Wendl, T., Schlender, J.F., Willmann, S., Lippert, J., Block, M., Eissing, T., and Teutonico, 
D. 2016. “Applied Concepts in PBPK Modeling: How to Build a PBPK/PD Model.” CPT Pharmacometrics Syst 
Pharmacol. 2016 Oct;5(10):516-531. 

Jongeneelen, F.J., and Berge, W.F. 2011. “A generic, cross-chemical predictive PBTK model with multiple entry routes 
running as application in MS Excel; design of the model and comparison of predictions with experimental results.” 
Ann Occup Hyg. 2011 Oct;55(8):841-64. 

Pendse, S., Efremenko, A., Hack, C.E., Moreau, M., Mallick, P., Dzierlanga, M., Nicolas, C.I., Yoon, M., Clewell, H.J., 
and McMullen, P.D. 2020. “Population Life-course exposure to health effects model (PLETHEM): An R package for 
PBPK modeling.” Available at: https://www.scitovation.com/what-is-pbpk-modeling/. 

Wambaugh, J.F., Wetmore, B.A., Pearce, R., Strope, C., Goldsmith, R., Sluka, J.P., Sedykh, A., Tropsha, A., Bosgra, 
S., Shah, I., Judson, R., Thomas, R.S., and Setzer, R.W. 2015. “Toxicokinetic Triage for Environmental Chemicals.” 
Toxicol Sci. 2015 Sep;147(1):55-67. 

Mallick, P., Moreau, M., Song, G., Efremenko, A.Y., Pendse, S.N., Creek, M.R., Osimitz, T.G., Hines, R.N., 
Hinderliter, P., Clewell, H.J., Lake, B.G., and Yoon, M. 2020. “Development and Application of a Life-Stage 
Physiologically Based Pharmacokinetic (PBPK) Model to the Assessment of Internal Dose of Pyrethroids in 
Humans.” Toxicol Sci. 2020 Jan 1;173(1):86-99. 

Tan, Y.M., Worley, R.R., Leonard, J.A., and Fisher, J.W. 2018. “Challenges Associated With Applying Physiologically 
Based Pharmacokinetic Modeling for Public Health Decision-Making.” Toxicol Sci. 2018 Apr 1;162(2):341-348. 
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Thompson, C.M., Sonawane, B., Barton, H.A., DeWoskin, R.S., Lipscomb, J.C., Schlosser, P., Chiu, W.A., and 
Krishnan, K. 2008. “Approaches for applications of physiologically based pharmacokinetic models in risk 
assessment.” J. Toxicol. Environ. Health. B. Crit. Rev. 11(7): 519-47. 
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5 Getting Started with PLETHEM 
All tools in this guide are now available online. This means that the user is no longer required to install 
the software on their local machine. Below we give links to the individual portions of the guide. 

Module of PLETHEM Link to Module 

Rapid PBPK www.scitovation.com/OnlineTools/RapidPBPK 

HT-IVIVE www.scitovation.com/OnlineTools/HT-IVIVE 

KMD Tool www.scitovation.com/OnlineTools/KMD 

Ecotox PBPK www.scitovation.com/OnlineTools/EcotoxPBPK 

Intrinsic Clearance www.scitovation.com/OnlineTools/Clearance 

 

 

 

 

http://www.scitovation.com/OnlineTools/RapidPBPK
http://www.scitovation.com/OnlineTools/HT-IVIVE
http://www.scitovation.com/OnlineTools/KMD
http://www.scitovation.com/OnlineTools/EcotoxPBPK
http://www.scitovation.com/OnlineTools/Clearance
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6 Modeling using the rapidPBPK model  

6.1 Loading and running an existing project 

6.1.1 Loading an existing forward dosimetry project 
a. Go to File and click on the “Load” tab. This will open a dialog box called “Load New Project.” 

 

b. Click “Confirm.” This opens a new window where you can navigate to the location where you have stored 
materials for this and select “plethem_demo_project.Rdata.”  

c. After the project loads, the forward dosimetry user interface will launch in the systems default browser with 
all the datasets and simulations populated in the user interface. We recommend using Google Chrome as the 
default browser.  

6.1.2 Running a forward dosimetry simulation and looking at the results 
a. Click on “Model Setup” on the top navigation bar. Navigate to the “Simulations” tab on the model setup 

page. 
b. Select “Simple Forward Dosimetry Simulation” from the drop-down menu and click on “Run Simulation.” 
c. Under the Model Outputs tab, select the concentration plots pane. Arterial plasma concentration is plotted 

and the resulting plot should look like this: 

 

https://www.scitovation.com/wp-content/uploads/2020/09/plethem_demo_project.zip
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6.1.3 Running a Monte Carlo simulation and looking at results 

a. Navigate back to the “Simulations” tab under the “Model Setup” user interface.  
b. Select “Forward Dosimetry with Monte Carlo simulation” from the drop-down menu and click on run 

simulation. 
c. Under the Model Outputs tab, select the concentration plots pane. Plot Arterial Plasma concentration. 

 

 

6.1.4 Exiting the modeling user interface 
a. To exit the modeling interface at any point in time, just click the file button on the main navigation bar and 

click “Quit.”  
b. This will open a dialog box asking if the user wants to exit this modeling session. Any changes made to the 

project since the last save will be lost. (Note: PLETHEM can only run one project at a time. To open a 
different project, the user must exit the existing modeling session as outlined here.) 

c. Click the confirm button to exit the session. The main window will turn gray. 
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6.2 Creating a project for a new model 

Creating a new model project is the same for forward dosimetry, reverse dosimetry, and route-to-route extrapolation: 

a. Under the file menu, select “New” to create a PLETHEM project file to which the model can be saved. 
b. This opens the “Reset the current project?” dialog box. Click “confirm. 
c. You will be able to save the project and any point and re-open it when needed. When you click save, the 

project will be downloaded on your computer and called “plethem_project”. 

After you have created a project, you can exit it anytime by clicking the file button on the main navigation bar and 
clicking “Quit.” This will create a dialog box asking if the user wants to exit this modeling session. Don’t forget to 
save any changes made before exiting the session.  

If you quit the project as outlined above, please reload it by following the instructions in the “Load existing project” 
section before proceeding.  

After the project has been established, you can start creating datasets for the model. PLETHEM uses a database to 
save all the parameter sets that users create for a project. The project file allows users to export the project to an RData 
file that can be shared with other PLETHEM users.  

6.3 Creating datasets for the simulation 

This guide aims to take users through creating datasets and simulations. PLETHEM has built-in defaults for a large 
set of parameters needed to fully parameterize PBPK models. Users do not need to set all these parameters 
individually. PLETHEM uses the default values in our databases. 

6.3.1 Creating an exposure dataset 
a. Open the model setup user interface by clicking on “Model Setup” on the navigation bar at the top. 
b. Navigate to the “Exposure” tab.  
c. Select the route of exposure desired from the sidebar to show the specific exposure inputs. The exposure 

options are: Oral, Drinking Water, Oral Exposure with Vehicle, Inhalation, Intravenous, and Dermal. 
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d. Enter a value for each box relative to dose of exposure and duration of exposure. 
e. Click the “Save As” button. 
f. Give the dataset a name and a description. 
g. Click the “Add” button to save the set. 
h. This creates an exposure set, and the drop-down menu in the exposure tab is auto updated to show the set 

that was just created. (In order to add multiple exposure routes, click the “Reset Exposures” button before 
adding a new exposure.) 

6.3.2 Creating a chemical dataset 
a. Click on the “Chemical” tab in the user interface. 

 

b. At this stage, you can enter manually the chemical parameters, or you can import them. 
c. To import the chemical parameters, click the import button. This opens a window with tabs for the main 

database (“PLETHEM Database”), “Import from file,” and “User Database.”  
• If you want to use one of the PLETHEM chemicals, click on the “Select Chemical” drop-down menu, 

click on the chemical of choice, and then click “Import.”  
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• You can also import chemical information from a file. Click on “Browse.” This will open a window where 
PLETHEM will ask you to select the file you want to import. Find your file and select the type of file you 
are importing (“Chemical Input File” or “OPERA Predictions”). 

d. After selecting a QSAR model, click on the “Estimate Fraction Dissolved” button to estimate fraction of the 
chemical dissolved in the liquid phase of plasma.  

Fraction Dissolved in Liquid Phase of Plasma = 0.993

0.993+ .007 × 10𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑜𝑜/𝑤𝑤
 

e. Click the “Save As” button. A window will show what parameters have changed. 
f. Give the parameter dataset a name and a description. 
g. Click the “Add” button to save the set. 

6.3.3 Creating a physiological dataset 
a. Navigate to the “Physiological” tab in the use interface. 

 

 

b. Select the species and the gender under the “Organism” and the “Gender” drop-down menus, respectively.  
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c. Set the age under the “Age” drop-down menu. 

Click the “Calculate Physiological Parameters” button to parameterize the model using life-course equations in 
PLETHEM. (See Appendix 7 for these equations.) 

d. Click the “Save As” button to save the parameter set. Name the dataset and give a description. Click “Add” 
to save the physiological parameters. If the dataset does not appear in the drop-down menu right away, please 
refresh the page in the browser and check again. 

6.3.4 Creating an ADME set 
In PLETHEM, the ADME set is used to specify parameters related to absorption, distribution, metabolism, and 
excretion. They need to be defined for a specific combination of chemical, metabolite, exposure, and physiology. 

a. Navigate to the “ADME” tab in the user interface. 
b. If you have multiple exposure scenarios or multiple chemicals, select the right exposure and chemical set. If 

you want to track metabolites, select them in the drop-down menu or select no metabolites. 

 

c. Select the “Absorption” tab. You can keep the default value or enter your own value. This tab may be empty 
depending on the route of exposure that was chosen (e.g., Dermal, IV) 

 

If you have an oral exposure with a vehicule compartment (mostly for animal exposures), you can detail the transfer 
rate from the vehicule to the gut lumen.  

d. Select the “Distribution” tab.  
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e. Select “QSAR Model One” to be used for estimating partitioning. The “QSAR Model One” refers to the 
default QSAR model in PLETHEM, which is adapted from the algorithm published by DeJongh et al. in 
1997. (See Appendix 8 for these equations.) 

f. Click the “Calculate Partition” button to estimate partition coefficients for all tissues that are part of the 
model. You can also enter your own values. 

g. Each compartment can be described as blood flow limited or diffusion limited. PLETHEM assumes that the 
model is blood flow limited, which means that the permeability is set with a high value (1000). To switch the 
compartments to be diffusion limited, enter the appropriate permeability value. 

h. Select the “Metabolism” tab in the ADME user interface. You can enter your clearance values in vivo or 
perform IVIVE if you have in vitro intrinsic clearance. We use the IVIVE algorithm within PLETHEM to 
scale in vitro intrinsic clearance to intrinsic clearance in vivo. 

 

i. Click the “Perform IVIVE” button to open the IVIVE interface.  
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j. Select the organism. 
k. IVIVE can be run for whole hepatocytes, sub-cellular fractions, or S9 Fraction. Select the model of interest. 

For each model, select the metabolism type by clicking on “Saturable” or “Linear” in the drop-down menu. 
• If you select the “Whole Hepatocytes” tab, enter your Vmax or intrinsic clearance under “Hepatocyte 

Clearance” and select the units in the drop-down menu. 
• If you select the “Sub-cellular” tab, enter your Vmax or intrinsic clearance in “Microsomal Clearance” 

and/or “Cytosolic Clearance” and select the units in the drop-down menu.  
• If you select the “S9 Fraction” tab, enter a value for the “S9 Fraction Clearance” and select the units in 

the drop-down menu. 
• Note: If you have a Vmax and a Km (Michaelis-Menten Constant), you can enter these values in the 

interface. If you have an intrinsic clearance, put a value of 1 for the Km and enter the Vmax under 
“Hepatocyte Clearance” as the intrinsic clearance is defined as the ratio Vmax under Km. (See Appendix 
9 for these equations.) 

l. Click the “Perform IVIVE” button to extrapolate intrinsic clearance in vitro to intrinsic clearance in vivo.  
m. Click “Save As” to save the ADME scenario and name it. Click “Add” to save it. The entire ADME set is 

then saved along with the chemicals, physiology, and exposure set it represents. This will be used later to filter 
the appropriate ADME set for selection when creating a simulation from these building blocks.  

n. You should now be able to see the exposure in the drop-down menu. 
o. It is also possible to upload age-based metabolism data by clicking on the “Upload Age-Based Metabolism 

Data” tab. A new window will open. This feature is not yet available in this version of Pethem. 
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i. Download the template file by clicking on “Template for metabolism file.”  
ii. Enter your data and save this file on your computer. 
iii. Click “Browse” and select the file you just saved on your computer. 
iv. Enter a name and a description and select the metabolism type. 
v. Click “Add Metabolism.” The new set of age metabolism data is now saved in the drop-down menu.  

 

vi. To apply the dataset, click on “Apply Data.” A window will appear to ask you to confirm as this will 
overwrite any existing data. Click “OK.” 

6.3.5 Creating a parameter variability dataset 
a. Navigate to the “Uncertainty and Variability” tab in the user interface. 
b. Select what kind of parameters you want to add variability to from the sidebar: “Chemical,” “Exposure,” 

“Physiological,” and/or “ADME.” 
c. Click on the “New” button. This opens a window where you can create a new variability set. 
d. Name the set and give it a description. 
e. From the drop-down menu, select the parameters for which you will be defining variability.  
f. Click on the “Update List” button to populate the table. 
g. Define a ‘Coefficient of Variation” (CV) and a distribution type. You can also set an Upper Limit or a Lower 

limit to avoid extreme values. 
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h. Click done to create the dataset.  

 

6.4 Combining all the sets to make a simulation 

6.4.1 Simulation Set: Creating a simple forward dosimetry simulation 
a. Navigate to the “Simulations” tab in the user interface.  
b. Click “New” to launch the “Simulation” dialog.  
c. Give a name to the simulation and a description. 
d. Select “Forward Dosimetry” in the “Simulation Type” tab. 
e. Under the “Parameters” tab, make sure the appropriate “Exposure,” “Parent Chemical,” “Physiology,” and 

“ADME” tabs are selected. 
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f. Under the “Simulation” tab, set the “Simulation Start Time” and the “Simulation Duration” as well as the 
“Duration Units.” 

 

g. Click the “Create Simulation” button to save the simulation. The simulation Description should be updated 
with all the simulation information. 

6.4.2 Simulation Set: Creating a simulation for performing forward dosimetry with Monte Carlo analysis 
a. Navigate to the “Simulations” tab in the user interface.  
b. Click “New” to launch the “Simulation” dialog.  
c. Give a name to the simulation and a description. 
d. Select “Forward dosimetry with Monte Carlo” in the “Simulation Type” tab. 
e. Under the “Parameters” tab, make sure the appropriate “Exposure,” “Parent Chemical,” “Physiology,” and 

“ADME” tabs are selected. 
f. Under the “Variability” tab, make sure that the variability you set up is selected under the appropriate menu 

(“Physiology,” “Exposure,” “Parent Chemical,” and/or “ADME”). 
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g. Under the “Simulation” tab, set the “Simulation Start Time,” the “Simulation Duration,” and the “Duration 
Units.” Select the “Number of Monte Carlo Runs” you want to run. 

 

h. Click the “Create Simulation” button to save the simulation. 

6.4.3 Simulation Set: Creating a simulation for performing reverse dosimetry 
6.4.3.1 Upload biomonitoring data 

a. Navigate to the “Biomonitoring Data” tab in the user interface 
b. Click the “New” button to launch the import Biomonitoring Data Dialog. 

 

c. Click “Browse” to find and upload the file containing the biomonitoring data. This file needs to be in “CSV” 
format. You will find a template called “Biomonitoring Data.csv” at https://www.scitovation.com/plethem/.  
After the data is uploaded, “Upload complete” will appear below the file name. 

d. Give the file a name and a description. 
e. Biomonitoring data are usually measured in blood or urine. Select the “Tissue Type” and the appropriate data 

units in the drop-down menu. 
f. Select the “Chemical Type” to define if the data is based on the parent compound or one of its metabolites. 

https://www.scitovation.com/plethem/
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g. Click “Save Set” to save the biomonitoring data. You will be able to see this kind of graphical representation 
of the biomonitoring data: 

 

 

6.4.3.2 Create a simulation 

a. Navigate to the “Simulations” tab in the user interface.  
b. Click “New” to launch the “Simulation” dialog. 
c. Name the simulation and add a description. 
d. Select “Reverse Dosimetry” under the “Simulation Type” in the drop-down menu. 

 

e. Under the “Parameters” tab, make sure the appropriate “Exposure,” “Parent Chemical,” “Physiology,” and 
“ADME” sets are selected. If a project contains multiple sets, you can select the appropriate one for the 
simulation you wish to perform using the drop-down menus. 

f. Under the “Variability” tab, make sure that you have selected the parameters that will vary in this simulation. 
g. The “Workflow Specific Inputs” tab allows users to define inputs and select datasets specific to the simulation 

type. For route-to-route extrapolation, we need to select the extrapolation exposure route and estimate the 
range and number of exposures to run within that range for the Discretized Bayesian Approach (DBA) 
algorithm. The dose ranges and number of doses selected are driven by a general understanding of the model 
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and scale of biomonitoring results. The DBA is an iterative algorithm for reverse dosimetry. It is very likely 
that in the initial range selected, either the range will be too wide, or the extremes will be too high or too low 
to estimate an exposure. The Cumulative Distribution Function (CDF) plot and the Probability Distribution 
Function (PDF) graphs from the outputs are useful in refining this initial dosage range. If the CDF has a long 
tail on one end and does not plateau on the other end, that indicates the expected exposure is outside the 
range currently selected. If the CDF has a long tail at the lower exposure, that means the expected exposure 
is higher than the current dose range; the reverse is true if the tail is at the higher exposures.  

h. Select the number of doses within the range for which to perform Monte Carlo calculation. Ideally this 
number will be between 20 and 40. 

i. Under the “Simulation” tab, set the “Simulation Start Time,” the “Simulation Duration,” and the duration 
units from the “Duration Units” drop-down menu. Select the “Number of Monte Carlo Runs” you want to 
run. 

j. Click the “Create Simulation” button to save the simulation. 

6.4.4 Simulation Set: Creating a simulation for performing route-to-route extrapolation 
Before creating a simulation set for performing route-to-route extrapolation, there are a few more steps to follow. 

6.4.4.1 Create the extrapolation exposure set 

a. Navigate to the “Model Setup” tab. 
b. Navigate to the “Exposure” tab” in the user interface. 
c. Click the “Reset Exposures” button to set all exposure values on the user interface to 0. PLETHEM can 

simulate only one active route of exposure at a time. If the exposure values for multiple routes are set, 
PLETHEM will show an alert and will not allow users to save exposure sets until the error is resolved. 

d. Select the route of exposure for the extrapolation from the sidebar. 
e. Set the dose of exposure to 1 and set all related parameters such as the duration of exposure. (The dose of 

exposure here is the route of exposure we want to extrapolate the dose for. We assign a dummy exposure 
value of 1 as PLETHEM requires exposure sets to have an exposure value.) 

f. Click the “Save As” button to save the exposure set and name it. 
g. Click “Add” to save the exposure. Now you should have two exposure sets saved in the drop-down menu. 

6.4.4.2 Create a simulation set 

a. Navigate to the “Simulation” tab in the user interface. 
b. Click “New” to launch the new “Simulation” dialog. 
c. Give the simulation a name and a description. 
d. Select “Route to Route Extrapolation” as the “Simulation Type.” 
e. Under the “Parameters” tab, make sure the appropriate “Exposure,” “Parent Chemical,” “Physiology,” and 

“ADME” with the original exposure scenario are selected. If your project contains multiple sets, you can 
select the set of your choice from the drop-down menu. 
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f. Under the “Variability” tab, make sure that the “Physiological,” “Chemical,” or “ADME” parameters you 
want to vary are selected. Since we will be estimating exposure, we cannot include exposure-related variability 
in this workflow. 

g. The “Workflow Specific Inputs” tab allows users to define inputs and select datasets specific to the given 
simulation type. For route-to-route extrapolation, we need to select the extrapolation exposure route and 
estimate for the range of exposures and the number of exposures to run within that range for the Discretized 
Bayesian Approach (DBA) algorithm. The dose ranges and number of doses selected are driven by a general 
understanding of the model and scale of biomonitoring results. The DBA is an iterative algorithm for reverse 
dosimetry. It is very likely that in the initial range selected, either the range will be too wide or the extremes 
too high or too low to estimate an exposure. The Cumulative Distribution Function (CDF) plot and the 
Probability Distribution Function (PDF) graphs from the outputs are useful in refining this initial dosage 
range. If the CDF has a long tail on one end and does not plateau on the other end, that indicates the expected 
exposure is outside the range currently selected. If the CDF has a long tail at the lower exposure, that means 
the expected exposure is higher than the current dose range; the reverse is true if the tail is at the higher 
exposures.  

h. Set the “Exposure Range” and select the number of doses to simulate within this range. Usually this number 
should be at least 20. 

i. Under the “Simulation” tab, set the “Simulation Start Time” to 0, the “Simulation Duration,” and the duration 
units from the “Duration Units” drop-down menu.  

j. Click the “Create Simulation” button to save the simulation. 

6.5 Running simulations and plotting results with the rapidPBPK model 

6.5.1 Run a simple forward dosimetry simulation 
a. Select “Simple Forward Dosimetry” model from the simulation dropdown, then click “Run Simulation.” 
b. After the simulation completes, the user interface switches to the model output tab. The “Model Output” tab 

allows users to view and export simulation results such as tissue concentrations and amounts. It also contains 
interfaces that import datasets to plot against simulation results enabling users to view results from Non-
compartmental Analysis. 
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6.5.2 Concentration plots  
a. Click on concentration plots to open the “Concentration Plot” panel.  
b. Select different compartments from the model tab. 

 

c. By default, the data is plotted in µM. Select the mg/L radio button and ensure that the model scale and graph 
window changes to reflect the change in units. 

d. Click on the table tab. This should show concentration data for the compartments selected as returned by the 
simulation.  
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e. Click the “Get Data” button. This opens a window that asks the user for a name and location to save the 
model results as a csv file.  

6.5.3 Adding external PK data  
a. External concentration data in mg/L can be added to the project and plotted against concentration simulation.  
b. Click the “Add Dataset” button at the top of the model output page to open the “Add Dataset” dialog box. 

 

c. Enter a name and a description for the dataset.  
d. Click the “Browse” button and navigate to the location on your machine where all the testing data is stored. 

Select the file to import. An example of formatted file to import in vivo data is provided: 
plethem_in_vivo_time_course.csv. 

e. This should create a table displaying the data that will be imported.  
f. Click the “Add Dataset” button to add the data to the project. 

6.5.4 Plotting PK data against simulation results 
a. Make sure that the “Plot” tab is selected in the “Concentration Plot” panel.  
b. Select the “Dataset” tab (next to the “Model” tab where you selected compartments in the previous step). 
c. Select the “Dataset” you imported from the “Select Datasets” dropdown.  
d. This plots the data on the graph beside it. Make sure the units selected are “mg/L.” 

6.5.5 Plotting exposure 
a. Go to the “Exposure Plots” pane.  
b. Plot both instantaneous exposure values as well as total exposure across the simulation duration for the active 

route of exposure or for all exposures (oral, drinking water, inhalation, and intravenous). 
c. The data behind the plots can be seen in the “Table” tab. 

https://www.scitovation.com/wp-content/uploads/2020/09/plethem_in_vivo_time_course.csv
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6.5.6 Plotting amounts 

a. Amounts can be plotted in the “Amount Plots” panel. 
b. Currently, we cannot plot amount data from external sources. 
c. These plots compare values of amounts of chemical in different compartments in the model.  

6.5.7 Mass balance  
The Mass balance plot ensures that the model is well balanced. The curve should stay about 0. 

6.5.8 Parameters 

a. Click the “Parameters” tab at the top to view the parameters table. 
b. You can see three tables, one for exposure, physiological, and chemical parameters.  

 

6.5.9 Running the Monte Carlo analysis 

a. Navigate back to the “Simulations” tab on the “Model Setup” page. 
b. Select the forward Simulation that was created with Monte Carlo. 
c. Click the “Run Simulation” button. Running Monte Carlo simulations take more time. After the simulation 

is complete, the user interface will switch to the “Model Output” tab. 
d. The concentration and amount plots change to box plots with Cmax values for each dose. 
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6.5.10 Running reverse dosimetry analysis 

a. Navigate back to the “Simulations” tab on the “Model Setup” page. 
b. Select the Reverse Dosimetry Simulation that was created. 
c. Click the “Run Simulation” button. By running reverse dosimetry, the model runs multiple doses with Monte 

Carlo simulations, which take more time. After the simulation is complete, the user interface will switch to 
the “Model Output” tab. 

After the simulation is complete, PLETHEM runs the reverse dosimetry algorithm at the back end 
and creates a Cumulative Distribution Function (CDF) plot and a Probability Distribution Function 
(PDF) plot for the expected exposure. If the dose ranges are adequate, the graphs resemble CDFs 
and PDFs for log-normal distributions as in the figure below.  

 

d. The percentile values for the expected exposure are displayed under the “Exposure Estimates” tab. In the 
case study displayed here, using the model we parameterized, we expect the median exposure for the 
population to be approximately 0.0069ppm. 
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6.5.11 Running route-to-route extrapolation 

a. Navigate back to the “Simulations” tab on the “Model Setup” page. 
b. Select the route-to-route extrapolation simulation that was created. 
c. Click the “Run Simulation” button. PLETHEM will first simulate the model with the original exposure set 

(oral exposure, for example) to generate a reference plasma concentration. Then PLETHEM will run the 
Monte Carlo simulations needed to run the DBA algorithm that estimate exposure through the exposure 
desired (inhalation exposure, for example). This process can take a long time. The progress bar will update 
users on the number of exposures the model has run. After the calculations are complete, PLETHEM will 
navigate to the “Model Output” tab to display the results. 

d. After the simulation is complete, PLETHEM will run the reverse dosimetry algorithm at the back end and 
create a Cumulative Distribution Function (CDF) plot and a Probability Distribution Function (PDF) plot 
for the expected exposure. If the dose ranges are adequate, the graphs resemble CDFs and PDFs for log-
normal distributions. 

 

e. The percentile values for the expected exposure are displayed under the “Exposure Estimates” tab. 
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6.6 Importing exposure estimates into PLETHEM 

6.6.1 Importing SHEDS-HT 
SHEDS-HT is an R package for estimating exposures created by US-EPA National Exposure Research Lab (NERL). 
It makes use of the Consolidated Human Activity database and Consumer Product database to estimate exposure to 
chemicals in the population. The results are saved by SHEDS-HT in an output folder as a csv file for each chemical 
that was run for a specific scenario. The output folder structure for SHEDS-HT is illustrated in the figure below. The 
folder containing these scenarios should be selected as the data folder in the user interface. 

 
a. Navigate to the exposure tab in an open rapidPBPK project. 
b. Select “Import Data.” 
c. Select the “SHEDS Data” Tab. 

 

d. Click the “Select SHEDS Data Folder” tab. This will open an explorer window. 
e. Navigate to the folder where the SHEDS-HT results are stored and select it. (Make sure you select the folder 

one level above the “output” folder.) 
f. This will populate the “Select Scenario” dropdown with the scenarios that were run in SHEDS-HT. 
g. Select the chemicals you want to import data for from the “Select Chemical” drop-down menu. 
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h. Select “Population,” “Males,” or “Females” from the “Select Cohort” to indicate for which group to import 
exposure data.  

i. Click the “Import Selected Exposures” button to import the exposure estimates generated by SHEDS-HT. 
The exposure estimates will become available as exposure sets within the rapidPBPK project. 

6.6.2 Importing TRA exposure estimates 
ECETOC’s Targeted Risk Assessment (TRA) tool calculates the risk of chemical exposure for workers, consumers, 
and the environment. It has been identified by the European Commission’s Regulation on Registration, Evaluation, 
Authorization, and Restriction of Chemicals (REACH) as a preferred approach for evaluating consumer and worker 
health risks (ECHA, 2010 a,b). 

a. Navigate to the “Exposure” tab in an open rapidPBPK project. 
b. Select “Import Data.” 
c. Select the “TRA” tab. 
d. Click the “Browse” button under the “Upload Exposure Excel File” caption. 
e. Navigate to the location where the ECETOC TRA exposure Excel file is saved on your PC and select it. 
f. This uploads the file to the rapidPBPK project and populates the “Select exposures to export” dropdown 

with the scenarios that have been run in the TRA Excel sheet.  
g. Select the scenarios that you want to import into the project.  

h. Enter the molecular weight of the compound. This is needed because inhalation exposures are estimated in 
mg/L by TRA but are needed in ppm by PLETHEM models.  

i. Enter the number of inhalation doses per week (1–7). 
j. Click the checkbox if the oral estimate should be repeated daily. 
k. Click the “Import Selected Exposures” button to import the exposures into the PLETHEM project. 
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6.6.3 Importing SEEM estimates into PLETHEM 
EPA National Center for Computational toxicology developed the ExpoCast SEEM model that predicts exposure 
estimates for a large set of compounds across different cohorts. SEEM estimates for chemicals are generated in bulk 
by the EPA, and estimates are made available as publicly accessible databases. The following steps show how to import 
exposure estimates from SEEM into PLETHEM. 

a. Navigate to the “Exposure” tab in an open rapidPBPK project. 
b. Select “Import Data.” 

c. Select the “SEEM Data” tab.  
d. Click the “Select SEEM Data File” button. This opens an explorer window.  
e. Navigate the “SEEM.sqlite” file that was downloaded from the link at the start of this document and click 

“OK.” This populates a set of radio buttons with categories as defined in the SEEM database. 
f. Select the category of chemicals for which you want to import the exposure estimates and click the “Get 

Selected Chemical List” button. This populates the drop-down menu underneath the “Select Chemicals to 
Import” label. 

g. From this menu, select the chemicals you want to import into the project. 
h. Select the type of exposures estimate you want to import for each chemical (Median and/or 95th percentile). 
i. Click the “Import Selected Exposures” button to add these estimates to the PBPK project. 

6.6.4 Importing ConsExpo exposure estimates into PLETHEM 
ConsExpo is developed by RIVM, the Dutch National Institute for Public Health and the Environment, and is a 
web application that can generate exposure estimates. ConsExpo results are exported as a csv file (example file 
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provided at https://www.scitovation.com/plethem/“plethem_consexpo_estimates.csv”). This csv file can be read 
by PLETHEM.  

a. Navigate to the “Exposure” tab in an open rapidPBPK project. 
b. Select “Import Data.” 
c. Select the “ConsExpo” tab. 
d. Click the “Browse” button under the “Upload ConsExpo File” caption. 
e. Navigate to the location where you have saved the results file from ConsExpo and click “OK.” 
f. This will populate the “Select Exposures to import” dropdown in the user interface.  

g. Select the scenarios that you wish to import into the project. Both inhalation and oral exposure estimates for 
each of the selected scenarios will be imported into PLETHEM.  

h. Finally click the “Import Selected Exposures” button to add these estimates to the PBPK project. 
 

6.6.5 Importing exposures using the batch import file 
Some exposure estimation tools export data in non-standard formats or formats that make it difficult to incorporate 
support for them within PLETHEM. In addition, the user may want to define his or her own set of exposures that 
are not generated by an exposure estimation tool. To account for all such uses, we have implemented the ability to 
import multiple exposures into the project using the batch exposure import Excel file. To import the data using the 
batch file, you will first need to download and populate the template “Exposures.xlsx.” Next steps are: 

a. Navigate to the “Exposure” tab in an open rapidPBPK project. 
b. Select “Import Data.” 
c. Select the “Batch Exposure” tab. 
d. Click the “Browse” button under the “Select Exposure File” caption. 
e. Navigate to the location where you have stored the “plethem_batch_exposure_template.xlsx” file, select the 

file and click “OK.” This will upload the file to PLETHEM. 
f. Now click on one of the exposure tabs underneath the “Browse” button to open that tab. 
g. Select all the exposures you wish to import into the project from each of these tables. 

https://www.scitovation.com/plethem/
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h. Finally, click the “Import Selected Exposures” button to add these estimates to the PBPK project. 
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7 Performing high-throughput IVIVE using PLETHEM 

7.1 Starting HT-IVIVE user interface and loading chemicals 

7.1.1 Launching the HT-IVIVE user interface 
a. Load the PLETHEM package using “library (plethem).” 
b. Start a new HT-IVIVE project by typing interactiveHT() on the R console. 
c. This launches the HT-IVIVE user interface in the default browser. 

 

7.1.2 Importing chemicals to the project 
a. Click on the “Import Chemical” button at the top of the Setup page. This opens the import chemical dialog 

with tabs for the main and user databases. (Some configurations cause a “invalid user database selected” 
message to appear. This can be safely ignored.)  

b. If you are using the “PLETHEM Database,” select the chemical from that drop-down menu. 
c. If you are using your own database, select “User Database.” (User databases are in Sqlite format.) 
d. Navigate to the file you want to import and select it. 
e. Select the chemical from the “Select Chemical” drop-down menu. 

 

f. Note that the window to select the database may appear behind your browser window. Just minimize the 
RStudio and browser windows, and you should be able to see it. 

g. Click the “Import” button to import the chemical into the interface. 
h. Chemical information can also be imported from a .csv file. 

7.2 Parameterizing the HT-IVIVE model 

7.2.1 Entering physiological and chemical parameters 
 

a. To create a new model, click the “Add New Row” button in the user interface. This launches a new dialog 
box for parameterizing the HT-IVIVE model. The dialog box has tabs for the different inputs needed for the 
HT-IVIVE model. Most values are auto filled based on the parameter sets within PLETHEM and the selected 
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chemical. If you did not import a database or information on a specific chemical, you can select “Generic 
Chemical” from the “Select Chemical” tab and populate the chemical information yourself. 

 

b. Hovering over some input boxes results in the appearance of a popup text box suggesting valid inputs. These 
suggestions have not been calibrated for all inputs and can be ignored at this time. This will be addressed in 
upcoming versions of the tool. 

c. Navigate to the “Physiological and Chemical Parameters” tab in the dialog window. 
d. Enter the exposure estimate for this chemical in the “Environmental Exposure (mg/kg/day)” box. 
e. Finally give this estimate a name. 

 

  

7.2.2 Enter the in vitro point of departure 
Next, we enter the in vitro point of departure for the chemical selected.  
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Navigate to the “In vitro POD” tab in the dialog window and enter a value in the “In vitro POD” box. Make sure the 
appropriate unit is selected from the “Unit” drop-down menu. 

7.2.3 Select the HT-IVIVE type 
Navigate to the “HT-IVIVE Type” tab in the dialog window and select the kind of IVIVE that needs to be run. 

7.2.4 Parameterizing clearance models 
For metabolism, the model includes options for clearance in the liver, urine, and blood.  

a. Navigate to the “Hepatic Clearance” tab. You have the choice between “Subcellular Clearance,” “S9 Fraction 
Clearance,” “Whole Hepatocyte Clearance,” and “Enzymatic Clearance.” The clearance scaling can be done 
with the classic “Rowland Equation” or by assuming “Restrictive Clearance” or “Non-Restrictive Clearance.” 

i. If you select “Subcellular Fraction,” enter a value under “Microsomal Clearance” and/or “Cytosolic 
Clearance.” Make sure the appropriate units are selected from the “Units” drop-down menu. 

 
 

ii. If you select “S9 Fraction,” enter a value under “S9 Fraction Clearance.” Make sure the appropriate 
units are selected from the “Units” drop-down menu. 

iii. If you select “Whole Hepatocyte Clearance,” enter a value under “Whole Hepatocyte Clearance.” 
Make sure the appropriate units are selected from the “Units” drop-down menu. 

iv. Note: If you have a Vmax and a Km (Michaelis-Menten Constant), you can enter these values in the 
interface. If you have an intrinsic clearance, just put a value of 1 for the Km and enter the Vmax 
under “Clearance” as the intrinsic clearance is defined as the ratio Vmax under Km. 
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v. If you select “Enzymatic Clearance:”  
1. Download the “Template for CYP Clearance Data.” A csv file will open. 
2. Enter the in vitro clearance values for each enzyme metabolizing the chemical of interest. 

Units needs to be in µL/min/pmol protein. 
3. Click on the “Upload CYP Clearance” and select the csv file you saved on your computer 

with your enzyme’s clearances. This will populate the table with your enzymes of interest. 

 

b. Navigate to the “Renal Clearance” tab in the dialog window and check the “Include Renal Clearance box” if 
necessary.  
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c. If you also have clearance data in blood, in the “Clearance in Blood” section, enter a value in the “Measured 
Plasma Clearance” box. 

d. Click “OK” to parameterize the model with the values you just entered. The parameterized model is added 
as a row in the table on the “Setup” tab of the interface. 

 

7.3 Running the HT-IVIVE model and saving results 

7.3.1 Running the HT-IVIVE model  
a. At this point you can continue to add more chemicals into the project or add more points of departure for 

chemicals already in the project. After creating a model for each chemical and POD combination for which 
you want to calculate an equivalent applied dose, click the “Perform HT-IVIVE” button to run the HT-
IVIVE model. When completed, PLETHEM switches to the results tab.  

b. The results tab is a table that summarizes the input that went into the model along with certain calculated 
values from the model itself. 

c. The calculated parameters include: 
• Actual Hepatic/Renal/Plasma Clearance—the in vivo clearance in L/h that is calculated by scaling 

in vitro values to in vivo values. 
• CSS—the steady-state plasma concentration in vivo that will result from the standard 1 mg/kg/day 

exposure.  
• Equivalent dose—the equivalent applied dose in vivo that would generate a CSS equal to the 

observed point of departure in vitro.  
• Margin of Exposure—the ratio of the estimated in vivo exposure to the equivalent dose 

corresponding to the in vitro POD.  
d. The table can be copied to the clipboard for pasting into another program (e.g., Excel) using the “Copy” 

button or downloaded as a csv file using the “CSV” button on the screen.  
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8 Kinetically derived Maximum tolerated Dose workflow 

8.1 Template for the KMD workflow in PLETHEM 

Data for the KMD workflow in PLETHEM is defined in the Excel template “KMD Data Template.xlsx” that can be 
downloaded from the application itself. The figure below is a screenshot of the Excel file with data from an example 
study. The first two columns represent the nominal and actual exposure values for the experiment. The design of this 
inhalation study meant that the rats’ exposure as per the study design (nominal exposure) and the exposure to the 
rodents in the study (actual exposure) were the same. The last column on the spreadsheet is the replicate number for 
each exposure. PLETHEM needs this column to group the measured study values by exposure. The rest of the 
columns are for measured study values. For this case study, we used a small number of data points. It is important to 
note that all the data were not collected in a single experiment. Also, there were some replicates where values were 
not measured (encoded “NA”). 

 

8.2 Accessing the web application 

a. Since this workflow is entirely independent of the PBPK model in PLETHEM, it is best suited as a 
standalone tool that is available for use without needing to install R, RStudio, and the PLETHEM package. 

b. Open a web browser (preferably Google Chrome). 
c. Navigate to https://scitovation.shinyapps.io/plethem-MTD/ 
d. This will open the PLETHEM KMD web application. 

https://scitovation.shinyapps.io/plethem-MTD/
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8.3 KMD workflow in PLETHEM 

8.3.1 Upload the filled template 
a. Download the “Sample data file.” A .csv file called “kmd_sample_data.csv” will open. 
b. Enter your own data. The last column called “reps” is the number of replicates. Save this file on your 

computer. 
c. Click the “Browse…” button to open an upload file window. 
d. Navigate to the location on your computer where you have stored the template file downloaded in step a. 
e. Select the file to upload to the web-app. You will get a notification “Upload complete” under the 

“Browse...” tab. 
f. PLETHEM will run the KMD workflow for the first series of measurements. 

 

 

8.3.2 Interpreting the results 
a. Select the appropriate axis type by selecting “Log” or Linear under the “y-axis” and/or “x-axis” drop-down 

menu. 
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b. From the left side menu, choose the endpoint to display under the “Select Response Endpoint” drop-down 
menu. You will be able to see the values for each data point by navigating your mouse over the data point at 
each exposure. 

c. The blue circles represent the expected value of the measured endpoint if the dose response for the parameter 
is linear in the given dose range. The red circles represent measured values that are significantly different 
(either higher or lower) than the expected value. This indicates points at which the response no longer follows 
a linear dose response relationship and hence any doses beyond this range cannot be used for assessing human 
risk.  

 

d. The KMD table provides more detailed information on the statistics of nonlinearity. Choose the “table” tab 
above the graph to see the table. As this example indicates, the rats were exposed to increasing concentrations 
of a chemical up to 1600 ppm. None of the rats in the study showed any significant change in body weight 
throughout the study. Using classical Maximum Tolerated Dose (MTD) analysis, a top dose of 1600 ppm 
would have been used to perform further response in a lifetime study. However, the toxicokinetic profile 
shows a non-linearity in the dose response at 1200 ppm. This indicates that the kinetics of this chemical are 
no longer valid for extrapolation to humans beyond a highest dose of 1200 ppm, the kinetically derived 
maximum tolerated dose. This dose then should be used as the top dose in future studies. 
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9 Using forward dosimetry in ecotoxicology 
 

9.1 Creating a new project 

a. Load the PLETHEM package using “library(plethem).” 
b. Launch the PBPK modeling workflow by typing interactivePBPK(“fishPBPK”) in the R console. This 

launches the forward dosimetry user interface in the default browser. 

9.2 Creating an exposure set 

a. Navigate to the “Model Setup” tab. 
b. Navigate to the “Exposure” tab in the user interface. 
c. Set the “Concentration in Water.” 
d. Click the “Save As” button to save the set and name it.  
e. Click “Add” to save the exposure.  

9.3 Creating a chemical set 

a. Navigate to the “Chemical” tab in the user interface. 
b. Enter the appropriate input values. 

 

c. Click “Save As” to save the parameter set. 
d. Click “Add” to save chemical parameters.  
e. Note: The user has the choice of using Vmax and Km or an intrinsic clearance. If the user enters an intrinsic 

clearance, the Michaelis-Menten Constant (Km) needs to be set to 1. PLETHEM is calculating the intrinsic 
clearance as Vmax under Km. 
 

9.4 Creating a physiological set  

a. Navigate to the “Physiological” tab in the user interface. 
b. Select the species under the “Organism” drop-down menu.  
c. Enter the partition coefficient for the chemical in each tissues compartment. 



 

 

46 

PLETHEM v2.2.0 Short User Guide 
Updated April 6th, 2021 

 

 

d. Click the “Save As” button to save the parameter set. Name the set and click “Add” to save the physiological 
parameters. 

9.5  Define variability 

a. Navigate to the “Uncertainty and Variability” tab in the user interface. 
b. Select “Physiological,” “Chemical,” and/or “Exposure” from the sidebar to define which parameters will 

vary. 
c. Click on the “New” button to open the variability interface. Name this set. 
d. Select the parameters from the drop-down menu located under “Select Parameters to Assign Variability” and 

click the “Update List” button. This will also lead to different tissue volumes and blood flows to be scaled 
appropriately. 

e. Assign “Coefficient of Variation” and “Type of Distribution” to the parameters as shown in the figure below.  
f. Click “Done” to save the variability set. At this point, it is a good idea to save the entire project by clicking 

the “Save” button in the “File” menu. 

 

9.6 Create a simulation 

All the sets are put together to create a simulation.  

a. Navigate to the “Simulations” tab in the user interface. 
b. Click “Create New Simulation” to launch the “Simulation” dialog. 
c. Name the simulation and add a description.  
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d. Under the “Select Chemical,” “Select Exposure,” and “Select Compartment” tabs, make sure the appropriate 
“Chemical,” “Exposure,” and “Species” are selected.  

e. Under the “Variability” tab, make sure the right parameters are selected.  
f. Set the “Simulation Start Time” and the “Simulation Duration.” The default number of Monte Carlo runs is 

set to 1000. 
g. Check the “Run Monte Carlo Simulation” tab if you want to run a Monte Carlo analysis. 
h. Click the “Create Simulation” button to save the simulation. A window will pop up saying “Simulation saved 

as …” with the name you gave to that simulation. Click “OK.” You can now see information about your 
simulation on the screen. 

 

9.7 Run the simulation  

a. Select the simulation you wish to run from the drop-down menu. 
b. Click the “Run” button. If the selected simulation is a Monte Carlo simulation, a progress bar will appear 

above the “Run Simulation” as the simulation proceeds in the bottom right corner. 
c. After the simulation is complete, PLETHEM will switch over to the “Model Outputs” tab. 

 

9.8 View and export simulation results 

The “Model Output” tab allows users to view and export simulation results such as tissue concentrations and amounts. 
It also contains interfaces for importing datasets to plot against simulation results for viewing the results from Non-
compartmental Analysis.  

a. Select the “Plots” tab on the “Model Outputs” page. 
b. Select the “Concentration Plots” panel and select tissues from the multiple selection menu on the left. 
c. This creates a curve or for Monte Carlo analysis, a box plot for the tissue concentration in the plot window 

on the right.  
d. Selecting the “Table” tab on the concentration panel brings up the actual concentrations for each curve or 

Cmax value behind the box plot. These values can be exported by clicking the “Get Data” button below the 
table.  
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10 Appendix 
 

Appendices with examples for each of the workflows in the PLETHEM Workflow Tutorial Series are: 

• Appendix 1: Step-by-Step Guide: Forward Dosimetry 
• Appendix 2: Step-by-Step Guide: Route-to-Route Extrapolation 
• Appendix 3: Step-by-Step Guide: High-Throughput In Vitro to In Vivo Extrapolation (IVIVE) 
• Appendix 4: Step-by-Step Guide: Reverse Dosimetry 
• Appendix 5: Step-by-Step Guide: Kinetically Derived Maximum Tolerated Dose (KMD) Modeling 
• Appendix 6: Step-by-Step Guide: Using Forward Dosimetry in Ecotoxicology 
• Appendix 7: QSAR Model 1 Equations 

These appendices can be found at https://www.scitovation.com/plethem/. 

  

https://www.scitovation.com/plethem/
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Appendix 7: PLETHEM Life-course Equations 
 

Body Weight Female Under 22 Years 4 Months (kg) = 3.4 +  𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑐𝑐ℎ𝑖𝑖𝑖𝑖𝑖𝑖 𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤ℎ𝑡𝑡 ×𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦
3 ×𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦

+

 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎 𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤ℎ𝑡𝑡
1+142.11536 × 𝑒𝑒−.01028 ×𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎 𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤ℎ𝑡𝑡 ×𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦 

Body Weight Female Over 22 Years 4 Months (kg) = 
��2.19 × 10−8 × 𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚ℎ𝑠𝑠3 �− �1.22 × 10−4 × 𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚ℎ𝑠𝑠2�+0.12 ×𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚ℎ𝑠𝑠+50.824�× 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏 𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤ℎ𝑡𝑡 𝑎𝑎𝑎𝑎 𝑎𝑎𝑎𝑎𝑎𝑎 25

76.6
 

Body Weight Male Under 26 Years (kg) = 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏ℎ 𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤ℎ𝑡𝑡 + 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑐𝑐ℎ𝑖𝑖𝑖𝑖𝑖𝑖 𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤ℎ𝑡𝑡 × 𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦
ℎ𝑎𝑎𝑎𝑎𝑎𝑎+ 𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦

+

 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤ℎ𝑡𝑡 𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎
1+𝑘𝑘 × 𝑒𝑒−𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙𝑙 ×𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤ℎ𝑡𝑡 𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎 ×𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦𝑦 

Body Weight Male Over 26 Years (kg) = 
��2.19 × 10−8 × 𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚ℎ𝑠𝑠3 �− �1.22 × 10−4 × 𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚ℎ𝑠𝑠2�+0.12 ×𝑎𝑎𝑎𝑎𝑎𝑎 𝑖𝑖𝑖𝑖 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚ℎ𝑠𝑠+50.824�× 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚 𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏 𝑤𝑤𝑤𝑤𝑤𝑤𝑤𝑤ℎ𝑡𝑡 𝑎𝑎𝑎𝑎 𝑎𝑎𝑎𝑎𝑎𝑎 25

76.6
 

 

Cardiac Output (L/h) = Adipose Perfusion + Bone Perfusion + Brain Perfusion + Gonad Perfusion + Heart 
Perfusion + Kidney Perfusion + Liver Arterial Perfusion + Muscle Perfusion + Remaining Perfusion + Skin 
Perfusion + Thymus Perfusion + Intestine Perfusion + Pancreas Perfusion + Spleen Perfusion + Stomach 

Perfusion 

Hematocrit Factor Under 2 Years = 0.359 

  Hematocrit Factor 2 Years and Over = (1.12815 × 10−6  ×  𝐴𝐴𝐴𝐴𝐴𝐴 𝑖𝑖𝑖𝑖 𝑌𝑌𝑌𝑌𝑌𝑌𝑌𝑌𝑌𝑌3) − (1.72362 ×  10−4  ×
 𝐴𝐴𝐴𝐴𝐴𝐴 𝑖𝑖𝑖𝑖 𝑌𝑌𝑌𝑌𝑌𝑌𝑌𝑌𝑌𝑌2) + (8.15264 ×  10−3  × 𝐴𝐴𝐴𝐴𝐴𝐴 𝑖𝑖𝑖𝑖 𝑌𝑌𝑌𝑌𝑌𝑌𝑌𝑌𝑌𝑌) + 0.327363 

Fractional Blood Compartment Volume Female = 2.66 × 𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴 − 0.46 

Fractional Blood Compartment Volume Male = 3.33 × 𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴 − 0.81 

Slowly Perfused Tissue Volume = (Body Weight * 0.85) - (Gut Volume + Intestine Volume + Liver Volume + 
Blood Volume + Adipose Volume + Bone Volume + Brain Volume + Heart Volume + Kidney Volume + Lung 

Volume + Skin Volume + Muscle Volume + Rapidly Perfused Volume) 

Rapidly Perfused Tissue Volume Female = 2.464 * Gut Volume 

Rapidly Perfused Tissue Volume Male = 2.596 * Gut Volume 

Respiration Rate Male (L/h) = 0.96 * Cardiac Output + 58 

  Respiration Rate Male (L/h) = 0.62 * Cardiac Output + 82 

 

Tidal Volume Male at Rest (L) = 0.6842 × 𝑒𝑒log (0.07428
1.661 )  × 𝑒𝑒−0.1357∗𝑎𝑎𝑎𝑎𝑎𝑎 

Tidal Volume Male Light Exercise Age 1 or Over (L) = 1.661 ×  𝑒𝑒log (0.07428
1.661 )  × 𝑒𝑒−0.1095∗𝑎𝑎𝑎𝑎𝑎𝑎 
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Tidal Volume Male Light Exercise Less than Age 1 (L) = 0.1041 × 𝑎𝑎𝑎𝑎𝑎𝑎2.727  ×  1.478−0.1041
𝑎𝑎𝑔𝑔𝑒𝑒2.727+ 12.232.727 

Tidal Volume Female at Rest (L) = 0.02712 + 𝑎𝑎𝑎𝑎𝑎𝑎0.9173  ×  0.9599−0.02712
𝑎𝑎𝑎𝑎𝑎𝑎0.9173+ 27.010.9173 

Tidal Volume Female Light Exercise Age 1 or Over (L) = 1.159 × 𝑒𝑒log (0.07248
1.159 )  × 𝑒𝑒−0.1362∗𝑎𝑎𝑎𝑎𝑎𝑎 

Tidal Volume Female Light Exercise Less than Age 1 (L) = 0.1036 × 𝑎𝑎𝑎𝑎𝑎𝑎3.064  ×  1.055−0.1036
𝑎𝑎𝑔𝑔𝑒𝑒3.064+ 9.583.064 

Dead Space Male (L) = 0.17 ×  𝑒𝑒log (0.01371
0.17 )  × 𝑒𝑒(−0.13 ×𝑎𝑎𝑎𝑎𝑒𝑒) 

Dead Space Female (L) = 0.1274 × 𝑒𝑒log (0.013745
0.1274 )  ×  𝑒𝑒(−0.1609 ×𝑎𝑎𝑎𝑎𝑒𝑒) 

Urinary Flow Rate Male (L/kg/day) = −2.96538 ×  10−6  ×  𝑎𝑎𝑎𝑎𝑎𝑎4 + 7.71852 ×  10−4  ×  𝑎𝑎𝑎𝑎𝑎𝑎3 −
.0754327 × 𝑎𝑎𝑎𝑎𝑎𝑎2 + 3.04687 × 𝑎𝑎𝑎𝑎𝑎𝑎 + 12.6931 

Urinary Flow Rate Female (L/kg/day) = 1.59275 × 10−4  ×  𝑎𝑎𝑎𝑎𝑎𝑎3 − .0309917 × 𝑎𝑎𝑎𝑎𝑎𝑎2 + 1.70013 × 𝑎𝑎𝑎𝑎𝑎𝑎 +
20.7921 
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Appendix 8: PLETHEM Life-course Equations 

Fat Partition Coefficient = 
0.8 × 𝐾𝐾𝑜𝑜/𝑤𝑤

1.03 + 0.2

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
1.03 + 0.83

− 3 

Skin Partition Coefficient = 
0.031 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.81 + 0.792

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.81 + 0.83

− 0.22 

Muscle Partition Coefficient = 
0.031 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.81 + 0.792

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.81 + 0.83

− 0.22 

Bone Partition Coefficient = 
0.031 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.81 + 0.792

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.81 + 0.83

− 0.22 

Brain Partition Coefficient = 
0.133 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.48 + 0.775

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.48 + 0.83

− 0.21 

Lung Partition Coefficient = 
0.031 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.81 + 0.792

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.81 + 0.83

− 0.22 

Heart Partition Coefficient = 
0.031 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.81 + 0.792

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.81 + 0.83

− 0.22 

GI Partition Coefficient = 
.049 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.81 + 0.711

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.81 + 0.83

− 0.35 

Liver Partition Coefficient = 
.049 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.81 + 0.711

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.81 + 0.83

− 0.35 

Kidney Partition Coefficient = 
0.053 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.57 + 0.785

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.57 + 0.83

− 0.19 

Rapidly Perfused Tissue Partition Coefficient = 
.049 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.81 + 0.711

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.81 + 0.83

− 0.35 

Slowly Perfused Tissue Partition Coefficient = 
0.031 × 𝐾𝐾𝑜𝑜/𝑤𝑤

0.81 + 0.792

0.0056 × 𝐾𝐾𝑜𝑜/𝑤𝑤
0.81 + 0.83

− 0.22 
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Appendix 9: PLETHEM Life-course Equations 
IVIVE Equations with Whole Hepatocytes 

Scaling Equations if using Vmax 

 

When Using Vmax to Calculate Maximum Metabolism Rate 

Maximum Metabolism Rate (μmol/h/kg BW0.75) = 

clearance (L/h) * 1000 (mL/L) * 1 (cm3/mL) * density (g/cm3) * 

(molecular weight (g/mol))-1 * 1000 (mmol/mol) * 1000 (umol/mmol) * 

(1/(kg BW)0.75) 

 

Maximum Metabolism Rate (μmol/h/kg BW0.75) = 

clearance (L/h/106 hepatocytes) * hepatocytes per gram liver (106 hepatocytes/g liver) * 

liver weight (kg liver) * 1000 (g/kg) * 

1000 (mL/L) * 1 (cm3/mL) * density (g/cm3) * 

(molecular weight (g/mol))-1 * 1000 (mmol/mol) * 1000 (umol/mmol) * 

1/((kg BW)0.75) 

 

Maximum Metabolism Rate (μmol/h/kg BW0.75) = 

clearance (L/h/106 hepatocytes) * hepatocytes per gram liver (106 hepatocytes/g liver) * 

liver weight (kg liver) * 1000 (g/kg) * 

1/((kg BW)0.75) 

 

Scaling Equations if using Hepatic Clearance 

 

metabolism in the liver (L/h) = 

clearance (L/h/106 hepatocytes) * hepatocytes per gram liver (106 hepatocytes/g liver) * 

liver weight (kg liver) * 1000 (g/kg) 

 

metabolism in the liver (L/h) = 

clearance (L/h/106 hepatocytes) * hepatocytes per gram liver (106 hepatocytes/g liver) * 
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liver weight (kg) * 1000 (g/kg) * 1/1000 (mmol/umol) * 1/1000 (mol/mmol) * 

molecular weight (g/mol) * (density (g/cm3))^-1 * 1 (mL/cm3) * 1/1000 (L/mL) 

 

 

IVIVE Equations with the Sub-cellular Fraction 

 

When Using Vmax to Calculate Maximum Metabolism Rate 

Maximum Metabolism Rate (μmol/h/kg BW0.75) = 

umol/h/mg Protein * PPGL (protein per gram liver) * liver weight (kg) * 

1000 (g/kg) * 1/((body weight (kg))0.75) 

 

Scaling to calculate maximum metabolism in the liver 

 

metabolism in the liver (L/h) = 

L/h/mg Protein * PPGL (protein per gram liver) * liver weight (kg) * 1000 (g/kg) 

 

 

IVIVE Equations with the S9 Fraction 

 

When Using Vmax to Calculate Maximum Metabolism Rate 

Maximum Metabolism Rate (μmol/h/kg BW0.75) = 

S9clearance (uL/min/mg protein) * S9PPGL (mg protein/gram liver) * liver weight (kg) * 

1000 (g/kg) * density (g/cm3) * 1 (cm3/mL) * 1/1000 (mL/uL) * (MW (g/mol))^-1 * 

1000 (mmol/mol) * 1000 (umol/mmol) * 60 (min/h) * 1/(body weight (kg))^0.75) 

 

Maximum Metabolism Rate (μmol/h/kg BW0.75) = 

S9clearance (uL/h/mg protein) * S9PPGL (mg protein/gram liver) * liver weight (kg) * 

1000 (g/kg) * density (g/cm3) * 1 (cm3/mL) * 1/1000 (mL/uL) * (MW (g/mol))-1 * 

1000 (mmol/mol) * 1000 (umol/mmol) * 1/((body weight (kg))^0.75) 
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Maximum Metabolism Rate (μmol/h/kg BW0.75) = 

S9clearance (mL/min/mg protein) * S9PPGL (mg protein/gram liver) * liver weight (kg) * 

1000 (g/kg) * density (g/cm^3) * 1 (cm^3/mL) * (MW (g/mol))^-1 * 

1000 (mmol/mol) * 1000 (umol/mmol) * 60 (min/h) * ((body weight (kg))^0.75)^-1 

 

Maximum Metabolism Rate (μmol/h/kg BW0.75) = 

S9clearance (mL/h/mg protein) * S9PPGL (mg protein/gram liver) * liver weight (kg) * 

1000 (g/kg) * density (g/cm3) * 1 (cm3/mL) * (MW (g/mol))-1 * 

1000 (mmol/mol) * 1000 (umol/mmol) * 1/((body weight (kg))0.75) 

 

metabolism in the liver (L/h) = 

S9clearance (uL/min/mg protein) * S9PPGL (mg protein/gram liver) * liver weight (kg) * 

1000 (g/kg) * 1/1000 (mL/uL) * 1/1000 (L/mL) * 60 (min/h) 

 

metabolism in the liver (L/h) = 

S9clearance (uL/h/mg protein) * S9PPGL (mg protein/gram liver) * liver weight (kg) * 

1000 (g/kg) * 1/1000 (mL/uL) * 1/1000 (L/mL) 

 

metabolism in the liver (L/h) = 

S9clearance (mL/min/mg protein) * S9PPGL (mg protein/gram liver) * liver weight (kg) * 

1000 (g/kg) * 1/1000 (L/mL) * 60 (min/h) 

 

metabolism in the liver (L/h) = 

S9clearance (mL/h/mg protein) * S9PPGL (mg protein/gram liver) * liver weight (kg) * 

1000 (g/kg) * 1/1000 (L/mL) 
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